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4
Making Magic

Chapter 3 is all about consuming media, and this chapter is about 

the flip side of the coin: making or transforming media. Lion 

comes equipped with tools that allow you to create professional-

looking results without spending a professional amount of money.

In this chapter, I cover editing snapshots, creating a slideshow, 

and creating a simple Web site.
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Make Your Photos Better Project
Difficulty level: Moderate

Additional software: Flare, iPhoto

Additional hardware: None

iPhoto does more than just store your pictures. It can also make those 
pictures look even better than they did right out of your camera. iPhoto 
lets you correct simple composition and technical errors easily, and you 
can even enhance the overall picture with a click. 

Flare is a neat little photo editor that allows you to go beyond what iPhoto 
does but doesn’t require you to have expert photo-editing knowledge.

Correct common photo problems
iPhoto has some built-in tools that correct comment problems like 
red-eye, upside-down pictures, and shots that are a little off kilter. 

Quick Fixing red-eye, orientation, and alignment:

1. Launch iPhoto.

2. Double-click the picture you want to edit.

3. Click the Edit button at the bottom of the window.

iPhoto’s edit window opens, displaying three tabs of options—Quick 
Fixes, Effects, and Adjust—on the right side of the screen. (I discuss 
the Effects tab in the next task.)

Figure 4.1 shows a photo of my wife that I scanned in; it’s upside 
down and suffers from some red-eye. (Sorry, honey!) A couple of 
Quick Fixes will do the trick, though.
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Quick Fixes tab

Click to rotate counterclockwise.

Click to correct red eyes.

Click to straighten.

4. In the Quick Fixes tab, click the Rotate button to rotate the photo 
90 degrees counterclockwise; then click it again to turn the 
photo right side up.

My lovely wife is still sporting some red-eye in the picture, though, 
so I should fix that.

5. Click the Fix Red-Eye button to reveal the Red-Eye options (Figure 4.2).

Auto-Fix Red-Eye is selected, but sometimes, that setting 
isn’t enough.

Figure 4.1 You can edit 
images in iPhoto.

Figure 4.2 The Fix 
Red-Eye options in 
iPhoto.
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6. Zoom in to the photo, using the Zoom control in the bottom-left 
corner of the iPhoto window (Figure 4.3), to see just how red 
Marisa’s eyes are.

They’re still pretty red, so a little manual red-eye adjustment is 
in order.

7. Use the Size slider in the Fix Red-Eye section (refer to Figure 4.2), 
and match the size of the red-eye tool to the red area of one eye.

8. Click the red area to remove the red-eye.

9. Repeat steps 7 and 8 for the other eye.

10. Click Done.

11. Finally, to straighten the picture, click the Straighten button (refer to 
Figure 4.1).

The Straighten controls appear (Figure 4.4).

12. Slide the Angle slider.

iPhoto rotates and zooms in on the image, and yellow guidelines 
appear so that you can align something in the picture with a straight 
line (Figure 4.5).

13. When you’re happy with the results, click the Done button below the 
Angle slider.

Figure 4.4 Fix a crooked 
image with these controls.

Figure 4.5 Guidelines help you straighten 
your picture.

Figure 4.3 The iPhoto 
Zoom slider.
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Apply iPhoto effects
Your photo looks great now, but perhaps you want to have a little fun 
with it. The Effects tab of the edit window includes a couple of sections 
that allow you to change the way your photo looks, as you do in the 
following task.

Setting iPhoto effects:

1. Complete steps 1–3 of “Quick Fixing red-eye, orientation, and align-
ment” earlier in this project.

2. Click the Effects tab to display the Effects options (Figure 4.6).

3. Set any or all of the following effects:

• Brightness and contrast. Click the three orbs in the top row to 
lighten or darken the photo, or to adjust its contrast.

• Tone and saturation. The three orbs in the next row pump up 
the effects volume, making the photo warmer, cooler, or more 
saturated.

Figure 4.6 iPhoto 
offers a few effects 
that you can apply to 
your pictures.
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• Image effect previews. iPhoto shows a little preview of each 
effect here. Click to apply it to your photo. See the “Layering 
Effects” sidebar for information about layering effects.

If you take your effects a little too far, you can always click the Undo 
button, which takes you back to the last thing you did, or the Revert to 
Previous button, which takes you back to the original photo.

4. Click the Edit button to save your work.

Layering Effects

You can click a few orbs at the top of the Effects tab to layer those effects on the photo. You can 

apply the second set of effects in multiples, too. Click an effect to apply it; click another to apply 

that one too.

You can get a complex image by combining several effects, as shown in Figure 4.7. The thumb-

nails for the active effects contain small numbers that let you know how many times each effect 

has been applied. To increase or decrease that number, hover over the thumbnail; two white 

triangles appear on either side of the number. Click the left triangle to decrease the number of 

applications of that effect; click the right triangle to increase it.

Figure 4.7  
An image with  
several effects 
applied.

note
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Give your photos some Flare
iPhoto’s effects are great fun, but they go only so far. If you’re really into 
applying effects and filters to your photos, you could spring for some-
thing like Adobe Photoshop, which costs lots of money, or you could get 
Flare (http://flareapp.com) from the Mac App Store for $19.99.

Flare is all about letting you apply effects to your photos quickly and 
simply. Here’s how to use Flare to give your photos some pizzazz.

Creating a custom preset in Flare:

1. Launch Flare.

2. Drag a photo onto the Flare icon in the Dock (Figure 4.8) or directly 
into the Flare window.

Flare displays the picture with some icons below it (Figure 4.9).

Rotate counterclockwise

Rotate clockwise

Crop

Figure 4.9 Loading an 
image into Flare for 
some editing.

Figure 4.8  
Flare’s icon.

http://flareapp.com
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3. Click the Presets tab at the top of the window.

Flare displays the available presets on the right side of the window 
(Figure 4.10).

4. Click the preset you want to apply.

5. Click the Edit button at the top of the window to display editing 
controls (Figure 4.11).

Figure 4.10 Flare 
comes loaded with a 
bunch of preset effects 
that you can apply to 
your images.

Figure 4.11 Editing a 
preset allows you to 
create your own cus-
tom presets.
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6. Set the options the way you want them, adding more effects and 
tweaking the existing ones.

7. Click the Save As Preset button at the bottom of the editing controls.

A save sheet drops down (Figure 4.12).

8. Enter a name for the preset, and click OK.

9. When you’re happy with your photo, click the Save or Export 
button (refer to the top-left corner of Figure 4.11) to share it with 
the world.

The sheet shown in Figure 4.13 drops down.

10. In the Save Image section, choose the appropriate radio button to 
save your image to a file, to Flickr, or to iPhoto, or to send it in an 
email message.

In addition to saving or exporting your photo outside Flare, you can save 
the image to Flare’s Snapshots by checking Save Effects to Snapshots. 
For more information, see the nearby “Setting Snapshots” sidebar.

Figure 4.12 Give your 
preset a good, descrip-
tive name.

Figure 4.13 Flare can 
save your image to a 
file, Flickr, or iPhoto, or 
in an email.



138 The Mac OS X Lion Project Book

11. Click the Save or Export button to save your masterpiece.

Now your custom preset will be listed with the default presets every 
time you launch Flare.

Setting Snapshots

Flare has a concept called Snapshots. If you click the Snapshots button in the top-right corner of 

the Flare window (refer to Figure 4.9), you’ll be taken to the Snapshots window (Figure 4.14). At 

any point, you can go into Snapshots, open one of these files, and edit it by clicking the snapshot 

you want to work with. 

You can add photos to the Snapshot area in two ways:

• Choosing Save Effect to Snapshots when you’re exporting your images, as mentioned earlier

• Clicking the Save to Snapshot button that appears when you’ve applied a preset and then 

clicked Edit (refer to Figure 4.11)

Figure 4.14  
Snapshots work in 
the background, 
saving an image so 
you can roll back 
changes.
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Make a Vacation Slideshow 
That Doesn’t Suck Project
Difficulty level: Easy

Additional software: iPhoto

Additional hardware: None

The advent of digital cameras plus cheap memory means that more 
people are taking more pictures than ever before. It also means that those 
people are forcing friends and neighbors to look at a never-ending stream 
of tear inducingly boring photo slideshows detailing their vacations. This 
project is going to show you how you can create a quick and easy photo 
slideshow that’s also entertaining. Think that’s impossible? Read on.

Create a slideshow
The most important trick to a good slideshow is editing. Resist the 
temptation to include every single pic you snapped, instead only show-
casing the pictures that came out well or tell an important part of the 
story (sometimes a blurry picture is much more interesting than a well 
framed and executed picture).

Building a slideshow:

1. Launch iPhoto.

2. Navigate to the section of your iPhoto library that includes the 
photos you want to include. They can be in the Photos section, in an 
Event, or in a Album (Figure 4.15).

Figure 4.15  
The iPhoto Library.
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3. Command-click each photo you want to include. A yellow border will 
appear around each photo, letting you know it is included in your 
selection (Figure 4.16).

You can include movies in a slideshow. When a movie appears in a 
slideshow it automatically starts to play.

4. Making sure you still have photos selected, click the Add To icon at 
the bottom of the iPhoto window (Figure 4.17).

5. Select Slideshow from the Add To menu (Figure 4.18). If you have an 
existing slideshow you can quickly add pictures to it by selecting it 
as the destination in the window; otherwise click the New Slideshow 
button (Figure 4.19).

Figure 4.16 A yellow 
border means an image 
is included in the cur-
rent selection.

tip

Figure 4.17  
The Add To icon.

Figure 4.18 You can 
add photos to a 
Slideshow or Album.

Figure 4.19 Selecting 
Slideshow gives you 
the option of creating a 
new one or adding the 
selected photos to an 
existing slideshow.
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Your new slideshow is created, and you’re taken to the slideshow 
editor (Figure 4.20). A title slide is created, and your cursor is 
placed in position to easily name your slideshow (the title of the 
slideshow will be updated to whatever you name the slideshow in 
iPhoto’s sidebar).

Edit a slideshow
At the top of the slideshow editor are all the slides in your show. The 
title slide is first, and the rest are ordered by date taken. You can rear-
range the slides any way you like by dragging them into a new order. 
The title slide must be the first slide of the show.

You can edit the text of the title slide by double-clicking it and typing 
something (Figure 4.21).

Figure 4.20  
The Slideshow editor.

Figure 4.21 Changing 
the title slide.
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At the bottom of the Slideshow editor is a row of icons:

• Both of these buttons cause the slideshow to start; Preview will run 
the slideshow within the Slideshow editor. Play starts the slideshow 
for real, meaning the slideshow goes full screen.

• Creates a movie file of your slideshow for viewing on other devices. 
This will be covered more in the exporting the slideshow section.

• Click this button to add another text slide to your slideshow. This is a 
great way to break up the slideshow into different sections. You can 
edit each text slide by selecting it and double-clicking the text.

• iPhoto has 12 slideshow themes for you to choose from. Click the 
Themes button and the Theme Chooser slides down, listing all the 
available themes (Figure 4.22). When you hover over one of the 
themes, a small preview of the theme plays. Click the theme you 
want to use and then click Choose. The slideshow editor updates to 
show the theme that you picked. To change themes again, just click 
the Themes button and select another.

Figure 4.22 iPhoto has 
a few Slideshow 
themes to choose 
from. Hover over one 
to see a little preview.
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• Pictures are great, but they’re even better when set to music. 
Clicking the Music button gives you some options to choose from for 
musical accompaniment (Figure 4.23). The first checkbox deter-
mines if music is played during the slideshow. Checked means music 
will play; unchecked is for no music.

The source menu lists a few sources for music: iTunes (with all your 
Playlists available), Sample Music (this music ships with iPhoto), 
and Theme Music (each theme has a song that Apple included with 
it; you don’t have to use it, obviously) (Figure 4.24).

Figure 4.23 Slideshow 
music settings.

Figure 4.24 You can 
choose music from a 
number of sources for 
your Slideshow.
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If you want to play more than one song click Custom Playlist for 
Slideshow (Figure 4.25). Drag the songs you want into the custom 
playlist area, and click Choose.

• There are two tabs on the Settings window, which appears upon 
clicking the Settings button, All Slides and This Slide (Figure 4.26). 
Settings in the All Slides section apply to the Slideshow, and all the 
slides in it, as a whole, while the This Slide settings only apply to the 
currently selected slide.

The All Slides section governs how your slideshow plays. You can set how 
long each slide is shown during the show (the music will repeat to play for 
the entire time) or have iPhoto look at the length of the music and play 
each slide long enough so that the song (or songs) only play once. By 
default each theme comes with a title slide, but you can hide the title slide 
by unchecking Show title slide. If you don’t want your slideshow to play 
over and over again in a loop, uncheck Repeat Slideshow.

Finally, you can set the aspect ratio of the slideshow (Figure 4.27). 
Pick whichever device you intend to play the slideshow back on, and 
you’re set (I am going to be streaming this slideshow to my Apple TV 
on my HDTV).

Figure 4.25 If you 
want to have more 
than one song play 
during your Slideshow, 
create a custom 
playlist.

Figure 4.26 The All 
Slides tab of the slide-
show settings apply to 
the entire slideshow.

Figure 4.27 A few 
aspect ratio options 
are available; choose 
with an eye on where 
this slideshow will be 
shown.
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The per slide settings in This Slide are of a more limited set (Figure 4.28). 
In fact, all you can do is apply one of three filters to the slide: Black & 
White, Sepia, and Antique. Clicking one will apply it; clicking the currently 
applied filter will remove it.

Your slideshow is now all set (Figure 4.29).

Share a slideshow
Your slideshow is complete, and it will remain listed in the Slideshow 
section of your iPhoto sidebar. You can go back and change any settings, 
add new pictures, and apply a new theme just by clicking it.

If you want to play the slideshow on your computer just click the Play 
button. You can also export the slideshow and email it to a friend, put it 
on a Web site (see the next project), or play it on another computer.

Exporting a slideshow as a QuickTime movie:

1. Launch iPhoto and select your slideshow in the sidebar.

2. Click the Export button.

A panel slides down with some devices at the top and four sizes 
listed on the left (Figure 4.30). If a dot appears in the column of the 
device then a movie of that size will play on that device. For example, 
medium is suitable for everything other except the iPhone, and 
Display is best suited for your Mac’s display.

Figure 4.28 This Slide 
settings apply only to 
the current slide.

Figure 4.29  
Slideshows have their 
own section in the 
iPhoto sidebar.

Figure 4.30 Export 
options for slideshows. 
This handy chart gives 
you an easy way to fig-
ure out which option is 
right for you.
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If you hover your mouse over the “i” at the end of each row iPhoto 
will display some information about the QuickTime encoding that 
will be used and the approximate size of the output file.

You can export more than one size at a time, so click the checkbox 
next to the sizes you want. If Automatically send slideshow to iTunes 
is checked the movie(s) will be added to iTunes for you.

Custom Export allows you to fiddle with the export settings and create 
a QuickTime file exactly as you want it.

3. Click Export and choose a location to save the file.

4. Click OK and iPhoto starts exporting the slideshow.

Once the slideshow is done exporting iTunes will launch, if you left the 
add to iTunes option checked, and start playing the file (Figure 4.31). 
Otherwise the file will be waiting in the location you saved it to.

tip

Figure 4.31 My slide-
show playing in iTunes.
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Create a Family Web Site Project
Difficulty level: Moderate

Additional software: RapidWeaver 

Additional hardware: none

Creating a Web site can be a daunting task. You have to know how to 
write code, or how to install a Content Management System. Or do you? 
There are a number of apps on the Mac that make creating, and 
updating, a Web site very easy.

Apple has a tool called iWeb, which is part of their iLife suite. I don’t 
recommend you use it, though, as Apple hasn’t updated it in a very long 
time. This usually signals that an app’s life is nearly at an end (of course 
Apple could prove me wrong and release an updated version at any 
point with super awesome features).

Instead of Apple’s tool, I recommend RapidWeaver from RealMac 
Software (www.realmacsoftware.com/rapidweaver/overview, $59.99; 
Figure 4.32). RapidWeaver is a powerful app that’s easy to learn how to 
use. Even better, there is a vibrant community of developers who create 
a variety of add-ons that you can purchase. These add-ons include more 
themes, and some even add features of their own to the application.

RapidWeaver is available from the Mac App Store, and a free demo is 
available directly from RealMac’s Web site so you can give it a try before 
you buy it.

Set up a site
You want to create a Web site to keep your family up to date with your 
zany adventures. Posting pictures and videos is important, and having a 
blog would be nice. Here’s how to do it with RapidWeaver.

Figure 4.32  
RapidWeaver icon.

www.realmacsoftware.com/rapidweaver/overview,$59.99
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Creating a site with RapidWeaver:

1. Launch RapidWeaver (Figure 4.33).

2. RapidWeaver is project based; click the Create a New RapidWeaver 
Project button to get started.

The main RapidWeaver window appears (Figure 4.34). On the left is 
the sidebar which includes Webpages, Resources, and Stats, and in 
the main window are a couple of things you should set up before you 
can delve into whipping up a Web site:

Figure 4.33  
RapidWeaver’s Project 
window.

Figure 4.34  
A RapidWeaver project 
just waiting for some 
content.
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• FTP Bookmarks. You need a place to host your Web site, and 
FTP is how you get the content from RapidWeaver to your server. 
Click the FTP Bookmarks icon to create a new FTP Bookmark 
(Figure 4.35).

Give your bookmark a name, choose a protocol (leave this set to FTP 
if you aren’t sure which to use), and enter your FTP server, user-
name, and password. The path tells RapidWeaver where on the 
server to upload your files. 

Consult your hosting company if you aren’t sure what these settings 
should be.

Click Test connection to make it all works and then close the window 
(you’ll be prompted to save your changes).

• Site Setup. Click Site Setup to enter some information about 
your site as a whole. There are three sections:

• General. Give your site a title and slogan (which will be displayed 
on the site) (Figure 4.36 on the next page). You can also enter 
some footer text that is displayed at the bottom of every page. 
The footer text defaults to a copyright notice and your name but 
you can change it to whatever you like.

Figure 4.35  
FTP Bookmarks hold 
your login information 
for eventual publishing.
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Next up is your Email Address and the text for the email link that’ll 
appear on your site (Contact Me is the default).

The web address should be the URL of your site, so RapidWeaver 
can correctly build your site’s internal links.

Finally, you can set a Site Logo, Web Clip, or Favicon. If you want to 
set any of these, they are optional; just click the checkbox next to 
the one(s) you want to use and then drag and drop an image in the 
well underneath the appropriate item.

If you would rather not have some, or all, of this information displayed 
on your site just uncheck all the fields (or just some).

• Advanced. You shouldn’t feel the need to change anything in the 
Advanced section, but it is nice to have the option (Figure 4.37). 
The first option, File Links are, determines how RapidWeaver 
builds links to files that you upload. It is fine to leave this as is.

Figure 4.36 General 
Site Settings apply to 
all the pages in your 
RapidWeaver project.

tip

Figure 4.37  
The Advanced settings 
allow you to turn on 
and off some 
functionality.
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You can also turn on and off some site options here including 
displaying a breadcrumb trail (this is a type of navigation that 
includes links at the top of each page tracing where you’ve been on 
the site), Protect email address (this encodes your email address so 
nasty spammers can’t harvest it from your Web site), generate XML 
sitemap (Google likes sites that do this), and enable cruftless links 
(this pretties up the URLs of your pages).

• Template. The template options give you control over the under-
lying structure of your site (Figure 4.38). Most of the options 
here can be ignored, unless you have a reason to change them, 
with one exception. If you want some text to show up in your 
site’s sidebar enter it in the Sidebar section. This text will show 
up on your site in the sidebar, depending on the theme you apply.

3. Click OK to apply your site settings.

4. Now that your FTP bookmarks are set up (this will be important 
when you’re ready to publish) and you’ve set up your general site 
information, it is time to start adding pages to your site. Click the 
Add page icon on the main screen or on the title bar (upper left 
hand side) and the page selector will slide down (Figure 4.39 on 
the next page).

Figure 4.38 Template 
settings apply to your 
site as a whole.
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Add Web-site content
For the site I’m building I want to include a blog, a welcome page (Styled 
Text), and a movie gallery. I’m going to start with the Styled Text page, 
which will also be the index page (default page) of my site.

Creating a welcome page:

1. Click the Add Page icon.

2. Double-click Styled Text.

3. Treat the Styled Text page just like you would a Word document 
(Figure 4.40). Type in some text, drag and drop a few pictures, and 
pretty soon you have yourself a Web page.

Figure 4.39  
RapidWeaver’s stan-
dard page types cover 
a wide range of 
content.

Figure 4.40 A Stylized 
Text page featuring a 
picture of your humble 
author.
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Notice in the sidebar I’ve named this page Home. You can change 
this name by double-clicking it and typing in a new one.

4. Once you have some text and pictures the way you like it, you should 
check out what your page will look like with a theme applied. Slide 
the button at the bottom of the RapidWeaver window from Edit to 
Preview (Figure 4.41).

The preview opens in the RapidWeaver window, and shows you 
what the page you’re working on will look like with the current 
theme applied (Figure 4.41).

If you don’t like the looks of an image, or any other media, you’ve 
added to the page, you can modify it. Select the image and click the 
Media Editor icon on the toolbar. This brings up the Media Editor, 
where you can set the size of the media, rotation, and add a shadow 
and border (Figure 4.43).

Figure 4.42 A page preview within RapidWeaver. Figure 4.43 The Media 
Editor allows you to change 
some settings on pictures/
movies.

Figure 4.41 To preview 
your page slide this 
slider to the right.



154 The Mac OS X Lion Project Book

Adjust page settings
I’ve gone ahead and repeated the steps detailed in “Add Web-site 
content” to add a blog and movie gallery to my site (Figure 4.44). Each 
page type has a number of different options available to it, which can’t 
all be covered in this project. However, you access the settings in the 
same place for each page type.

Changing page settings:

1. Click the page you want to modify in the sidebar. In this case I’m going 
to modify the Styled Text page, which has a pretty basic set of options.

2. Click the Page Info icon to bring up the Page Inspector. The Page 
Inspector has five sections:

• General. Here you can enable the page (disabled pages won’t 
show up on your site), Show In menu (if you uncheck this box 
this page won’t be included in your site’s navigation), and open in 
a window (Figure 4.45).

Page attributes like the Page Title (this shows up in the 
RapidWeaver sidebar) and Browser Title (which displays in a 
person’s browser when visiting this page) can be easily set here 
independently of one another.

Figure 4.44 The Blog 
Page adds a fully func-
tional blog to your site.
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Images are processed and uploaded with the page when you 
publish it. The General settings allow you to specify if images 
should be converted to a certain format, or kept in their original 
format. Compression levels are also defined here (for pictures 
that are converted only).

Finally, the bottom section of the General Settings allows you to 
override the Site Settings and give this page a specific title, 
slogan, and footer.

If you want these settings to be applied to all the pages on your 
site click Apply to All Pages.

• Sidebar. You set the sidebar text for the whole site in Site 
Settings; here you can override that text and display a custom 
page specific value (Figure 4.46).

• Header. The header settings for the whole site can be overridden 
for the selected page here (Figure 4.47).

Figure 4.45 The Page Inspector’s 
General settings.

Figure 4.46 Each page can have 
a customized sidebar.

Figure 4.47 Header information 
can also be customized on a per 
page basis
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• Styles. CSS, or Cascading Style Sheets, is a way of applying a 
design to a Web site. You can modify the styles applied to the 
selected page here (Figure 4.48).

• Page. The final section of settings varies from page type to page 
type. Styled Text doesn’t actually have any options here, so I 
selected the blog page with the Page Inspector (Figure 4.49). 
The Blog Page type has a number of different options displayed 
here. Be sure to explore this area for each of the page types you 
add to your site.

Each change you make is immediately applied to the page; there is no 
need to save changes.

Figure 4.48 The Styles 
tab gives you control 
over the code that 
styles your page (this 
is known as CSS).

Figure 4.49 Each page 
type also has page 
specific settings avail-
able in the last section. 
The Blog Page settings 
are shown here.
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Add a theme
You have content for your site, and you’ve tweaked the settings to your 
liking. The final step is to apply a theme that is pleasing to your eye.

RapidWeaver ships with a bunch of themes, and you can find more by 
clicking the Add-on icon on the toolbar.

Applying a theme:

1. Launch RapidWeaver and open the project that contains your site.

2. Select a page from the sidebar.

3. Click the Themes icon on the toolbar (Figure 4.50).

The Theme Browser appears at the bottom of the RapidWeaver 
window (Figure 4.51). The available themes are shown as thumb-
nails. You can increase or decrease the size of the thumbnails by 
using the slider on the right hand side. Entering a search term in the 
search field will filter the themes, and you can show all themes, only 
built-in themes, or third-party themes by choosing an option from 
the menu on the left.

Figure 4.50  
The Themes icon on 
the RapidWeaver 
toolbar.

Figure 4.51  
The Theme Browser.
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4. To apply a new theme, just click it in the Theme browser. When 
you’re in edit mode, you won’t see a change. To preview the theme, 
with the content in your site, slide the bottom slider to Preview 
(Figure 4.52).

Click another page while in preview to see the theme applied to that 
page’s content. If you don’t like the looks of the theme, just click 
another in the Theme Browser and the new theme is applied.

You can preview a page in your web browser of choice by Control-
clicking the page and selecting Preview from the menu (Figure 4.53). 
Select the browser you want to use, and the browser will launch and 
display your page.

Figure 4.52 Previewing 
a theme.
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Publish your site
Your site’s content is awesome, and you have applied the perfect theme. 
Now you just need to publish your site for the entire world to see.

Publishing the site:

1. Launch RapidWeaver and open your site’s project.

2. Click the Publish icon in the toolbar (Figure 4.54).

The Publish sheet will appear, with two options: FTP and MobileMe 
(Figure 4.55).

Figure 4.53 You can 
also preview a theme 
in the browser of your 
choice.

Figure 4.54  
The Publish icon is 
located at the top of the 
RapidWeaver window.

Figure 4.55 Publishing 
to FTP requires some 
information.
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3. Since we set up an FTP bookmark, click the Bookmark icon to select 
your saved information (Figure 4.56).

4. Click Publish, and RapidWeaver displays the publishing progress for 
each individual file (Figure 4.57). When RapidWeaver is finished 
publishing a big green check is displayed (Figure 4.58).

Figure 4.56 Fill in that 
information using the 
FTP bookmark we set 
up earlier.

Figure 4.57  
The upload progress is 
displayed.

Figure 4.58 Published!
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If you don’t want to RapidWeaver to actually push files to your remote 
server you can export your site to a folder on your Mac. Go to the File 
menu > Export Site. Choose a folder on your Mac and click Export. You 
can then use your favorite FTP client to upload the files manually.

If you point your browser to the URL of your site you’ll see the fancy 
site you’ve created in RapidWeaver on display (Figure 4.59). Give 
the URL to your friends, and bask in the glow of having your very 
own Web site.

This is a high level overview of RapidWeaver, and I’ve only touched 
on some of the features this rich app includes. Be sure to check out 
the RapidWeaver manual (Help > RapidWeaver Manual) for more 
information about the wealth of features and add-ons that exist for 
this product.

tip

Figure 4.59  
My RapidWeaver  
created site, live on  
the internet.
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Symbols
+ (plus icon)

for accessing search-attributes manager, 7
in Mission Control, 183

A
AAC format, exporting podcasts in, 198–200
abbreviations (snippets), 177
Accessing Your Mac Away from Home Project, 

68–82
Back to My Mac, using, 72–74
over a modem, 68–72
router-connected Macs. See sharing with router-

connected Macs
Advertise Globally Using Bonjour option, 78
AirPort Utility, 75–76, 80
albums

adding photos to, 140
album art, adding to podcasts, 195–196

alignment, fixing (photos), 130–132
All My Files folder, 6
All Slides section (slideshows), 144
Annotate tool, 218, 219
Apple

Apple Remote Desktop, 77–78
AppleScript, 176
iWeb tool, 147
NeXTSTEP and, 4

applications. See also Installing Applications Project
application-specific printer settings, 23
disk images and, 41–42
full-screen, 180, 181–183
launching with Spotlight, 16

Arrangement icon (Finder), 4–5
articles

reading, 168–169
sending to Instapaper, 171
style of, 168, 171
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adding to iTunes, 117, 119
adding to podcasts, 195–196, 197
display of apart from Macs, 124
modifying, 122

Artwork Editor (GarageBand), 196
aspect ratio (slideshows), setting, 144
audio, DVD settings for, 107–108
Audio Podcasting Project, 186–200

album art, adding, 195–196
editing, 192–195
exporting, 198–200
markers, 196–198
recording, 187–192
tips for, 186–187

Auto Save, 208
AutoCorrect (TextExpander), 178

B
Back to My Mac, 72–74
Backing Up Project, 200–214

backup strategies, creating, 214
folders, restoring, 206–208
off-site storage, 209
Time Machine, 201–206
Versions, 208–209

Bandwidth Change Settings button (Dropbox), 93
batteries, backups and, 205
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blogs
adding to Web sites, 154
settings, 154–156
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bootable clones. See also Backing Up Project
cloning startup drives, 210–212
updating, 212–214
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brightness and contrast, improving (photos), 133–134
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Butler, downloading, 42

C
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encoding, 115–116
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encoding DVDs and, 113–114
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clones, bootable. See also Backing Up Project
cloning startup drives, 210–212
updating, 212–214
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Copy Link, 35
copying

Clipboard and, 66
Copy Public Link window, 100
DVDs, 102–105
iTunes folder, 125
TV shows to iTunes, 116–119

Create a Family Web Site Project, 147–161
content, adding, 152–153
page settings, 154–156
pages, adding, 151–152
publishing, 159–161
site setup, 148–152
themes, adding, 157–159

customizing
HandBrake with presets, 106–107
photo presets, 136
shared screens, 66–67

D
Dashboard, 182, 183
date, filter searches using, 18–19
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custom printer presets, 27

Desktop
Apple Remote Desktop, 77–78
creating extra (Mission Control), 183
switching to full-screen apps, 181

detail page (Mac App Store), 36
Detail view (iTunes), 119
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cloning and, 210–211
encryption of, 202, 203
exporting podcasts to, 199–200
external for backups, 214
size required for Time Machine, 201

disk images, downloading, 41–42
Dock

Dock icon (HandBrake), 111
Finder icon in, 2
iTunes Dock icon, 116

document sharing, iChat Theater for, 52–55
downloading

disk images, 41–42
Download Rate (Dropbox), 93
Dropbox, 83–84
Heltweetica, 32–34

drives
creating clones of, 210–212
moving iTunes Library to external drives, 125–127

Dropbox
acquiring and setting up, 83–89
basics of, 83
configuring, 91–94
navigating, 90–91
Public folder, 99–100
using on the Web, 94–99

duplex printing, 21, 25
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E
editing

Media Editor (RapidWeaver), 153
podcasts, 192–195
slideshows, 141–145

effects
iPhoto, 133–134
sound effects (GarageBand), 189
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emailing PDFs, 29
on Web sites, 150, 151

encoding. See also Encode Entire Seasons of TV 
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canceling, 115–116
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encryption of backup disks, 202, 203
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podcasts, 198–200
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external storage, moving iTunes Library to, 125–127

F
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Home Project
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turning on File Sharing, 61–62
working with on Dropbox Web site, 95–97
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HandBrake, 110
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basics of, 2
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files, viewing in Finder window, 2–4
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folders with remote access and, 64
restoring folders and, 206
search tokens, 11

Flare
basics of, 130
custom presets, creating in, 135–138
Snapshots, 138

folders
folder invitations (Dropbox), 97–99
remote access and, 63–65
restoring, 206–208
syncing with Dropbox, 88
working with on Dropbox Web site, 95–96

font size in feeds, 171
“Four on a page” printer preset, creating, 25–27
FTP

FTP bookmarks, creating, 149
publishing to FTP, 159–161

full-screen mode
basics of, 179–181
Mission Control and, 182

G
GarageBand

album art, adding to podcasts with, 195–196
editing podcasts with, 192–194
main window, 189–190
recording podcasts with, 187–192

Get Your TV Shows and Movies into iTunes Project, 
115–124

adding TV series, 115–119
details, adding, 119–123
places for possible display of, 124
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H
HandBrake

customizing, 106–107
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headers settings (Web sites), 155
Heltweetica, 32–34

I
iCloud, 72
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Add to Queue icon, 113
Arrangement icon (Finder), 4–5
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Categories icon (Mac App Store), 31
Dock icon (HandBrake), 111
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Make a Vacation Slideshow That Doesn’t Suck 
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iTunes Project
exporting podcasts to, 198–199
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copying TV shows to, 116
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iWeb, 147

J
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Jobs, Steve, 4

L
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Spotlight, 12
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full-screen mode, 179–181
Mission Control, 182–183

local networks. See Sharing Screens and Files over a 
Home Network Project

login, remote Screen Sharing and, 59–60, 65, 71
Loop icon (GarageBand), 189
Lyrics tab (iTunes), 122

M
Mac

accessing. See Accessing Your Mac Away from 
Home Project

Back to My Mac, 72–74
restoring with Time Machine, 208
router-connected. See sharing with router-

connected Macs
syncing files. See Syncing Files Across Macs Project

Mac App Store, 30–39
acquiring apps, 31–35
basics of, 30–31
benefits of, 39
detail page, 36
updating apps, 36–39

MacUpdate, 40
Macworld, 40
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Make a Vacation Slideshow That Doesn’t Suck 
Project, 139–146

creating, 139–141
editing, 141–145
music, 143–144
sharing, 145–146
themes, 143
titles, 143

Make Your Photos Better Project
Flare basics, 130, 135–138
Flare Snapshots, 138
image effect previews, 134
layering, 134
red-eye, orientation, and alignment, 130–132
tone and saturation, 133–134

Managing Your Files Project, 2–11
arranging in Finder window, 4–6
viewing in Finder window, 2–4

markers, adding to podcasts, 196–198
Mastering Spotlight Project, 12–19

applications, launching with, 16
basics of, 2, 12
filters, setting, 16–19
preferences, setting, 14–15
searching with, 12–13
System Preferences, finding with, 19
working with results, 13–14

math calculations, 16
Media Editor (RapidWeaver), 153
Media Kind pop-up menu, 118
metadata from TV shows, adding to iTunes, 115–119
microphones, podcasts and, 187, 191
Mission Control, 182–183
MobileMe, 72
modems, accessing at a distance and, 68–72
Move Your iTunes Library Project, 124–127
movies. See also Get Your TV Shows and Movies into 

iTunes Project
movie galleries, adding to Web sites, 154
in slideshows, 140
of slideshows, 142
slideshows, exporting as, 145–146

moving
iTunes Library project, 124–127
TV shows to iTunes, 116–119

MP3s
encoding, 199
exporting podcasts and, 199
searching for with Spotlight, 18

Multiple Item Information window (iTunes), 116–117
music

adding to slideshows, 143–144
searching for with Spotlight, 18

N
NetNewsWire Lite

adding feeds to, 164–165
making default newsreader, 171–172
managing feeds with, 164–165
reading feeds with, 167–169
subscribing to blogs in, 166

NeXTSTEP, 4

O
off-site storage, 209
orientation

of paper for printing, 23, 25
of photos, fixing, 130–131

P
Page Inspector (RapidWeaver), 154–155, 156
pages, Web

adding to sites, 151–152
settings, 154–156
welcome pages, adding, 152–153

passwords
for disk backups, 202–204
password generators, 203
Screen Sharing and (iChat Theater), 60

PDFs
emailing, 29
PDF filter in Spotlight, 17
printing, 28, 29
sharing with iChat Theater, 53
Smart Folders and, 8–9
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Picture Settings panel, 110
pictures. See also Make Your Photos Better Project

inserting into snippets, 176
plug-ins, allowing (NetNewsWire Lite), 170
plus icon (+)

for accessing search-attributes manager, 7
in Mission Control, 183

podcasting. See Audio Podcasting Project
port mappings, creating in Time Capsule, 75–79
preferences

Dropbox, 91–94
Spotlight preferences, setting, 14–15
System Preferences, finding in Spotlight, 19

presets
creating custom (Flare), 135–138
customizing HandBrake with, 106–107
printer presets, 22, 25–27

previews
in Finder windows, 3
image effect previews, 134
page previews (RapidWeaver), 153
PDFs, 29
previewing themes (RapidWeaver), 158–159
Spotlight, 14
video output (HandBrake), 109–111

printer setup, 20
printing. See Saving Yourself Some Paper Project
Privacy tab, Spotlight and, 15
Public folder (Dropbox), 99–100
publishing Web sites, 159–161

Q
Queue, 112–115
Quick Fixes (iPhoto), 131
QuickLook, File Sharing and, 53
QuickTime movies, exporting slideshows as, 145–146

R
RapidWeaver. See also Create a Family Web Site 

Project
basics of, 147

reading feeds, 167–169
Really Simply Syndication (RSS), 164. See also feeds

recording podcasts, 187–192
red-eye, fixing, 130–132
Registered User radio button, 64
remote access

to files, 63–65
keeping Macs awake for, 82
to screens, 65–67

restoring
folders, 206–208
Mac with Time Machine, 208

rotation of photos, 130–131
routers, 74. See also sharing with router-connected 

Macs
RSS (Really Simply Syndication), 164. See also feeds

S
Safari

as default newsreader, 171–172
full-screen mode in, 180
launching with Spotlight, 16

saturation, fixing (iPhoto), 133–134
saving

paper. See Saving Yourself Some Paper Project
PDFs and, 29
photos, 138
podcast files, 188
Smart Folders, 9

Saving Yourself Some Paper Project, 20–29
basics of, 20
PDF print options, 29
print options, 21–23
printing presets, 25–27
printing with less paper, 24–25
printing without paper, 27–28

scaling, turning off, 67
Screen Sharing. See also Sharing Screens and Files 

over a Home Network Project
Back to My Mac and, 72–74
with iChat, 49–52
with iChat Theater, 52–55
modem connected Macs and, 68–71
with router-connected Macs, 79–81

screen shots (Mac App Store), 36
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scripts, defined, 176
searches. See also Mastering Spotlight Project

Mac App Store, 32
search criteria, 10
search tokens, 11
Smart Folders and, 7

security, virtual, 67
sharing

documents, 52–55
files. See Accessing Your Mac Away from Home 

Project
photos, 55
screens. See Sharing Screens and Files over a Home 

Network Project
slideshows, 145–146

Sharing Screens and Files over a Home Network 
Project, 56–68

File Sharing, 61–62
files, accessing remotely, 63–65
Screen Sharing, 56–61
screens, accessing remotely, 65–67

sharing with router-connected Macs, 74–82
basics of, 74
keeping Macs awake, 82
port mappings, creating in Time Capsule, 75–79
Screen Sharing and, 79–81

shell scripts, 176
sidebar text on Web sites, 155
Sign PDFs without Printing Them Project, 215–220

capturing signatures, 215–218
inserting signatures, 218–220

signatures
capturing, 215–218
inserting, 218–220

signing PDFs. See Sign PDFs without Printing Them 
Project

Smart Folders, 6–10
basics of, 6–7
creating, 7–9
search criteria, 10

Smart Update (SuperDuper!), 213
Smile on My Mac, 173
snapshots. See Make Your Photos Better Project

Snapshots (Flare), setting, 138
snippets

adding premade, 177–178
creating, 175–177
defined, 173
groups and grouping, 174, 178

songs, added to slideshows, 143–144
Sorting tab (iTunes), 118, 121
sound effects (GarageBand), 189
Source list (iTunes), 123
startup (Dropbox), 92
startup drives, cloning, 212–214
Staying on Top of the News Project, 164–172

feeds, adding, 165–167
feeds, basics, 164
feeds, managing, 164–165
feeds, reading, 167–169
NetNewsWire Lite as default reader, 171–173
NetNewsWire Lite, configuring, 170–171
RSS basics, 164

storage
moving iTunes Library to external storage, 125–127
off-site storage, 209
storage size (Dropbox), 86

style
Article Style (feeds), 168
Styled Text pages, 152
styling Web sites, 156
of text for snippets, 176

subtitles, settings for, 108
Summary tab (iTunes), 122–123
SuperDuper!

backup strategies and, 214
clones, creating with, 210–212
clones, updating with, 212–214

Syncing Files Across Macs Project, 83–100
Dropbox, acquiring and setting up, 83–89
Dropbox, configuring, 91–94
Dropbox, navigating, 90–91
Dropbox, using on the Web, 94–99
Dropbox Public folder, 99–100
selective syncing, 89

System Preferences, finding with Spotlight, 19



228 Index

T
Tech-Supporting Your Parents Project, 45–55

adding to buddy lists, 48–49
iChat Theater for document sharing, 52–55
Screen Sharing, 49–52
setup, 45–48

Tell a Friend option, 35
template options for Web sites, 151
text

adding to slideshows, 142
style for snippets, 176

themes
slideshows, 142
Web sites, 157–159

This Slide settings, 144, 145
Throw Away Your DVDs Project, 102–111

copying DVDs, 102–105
HandBrake, customizing with presets, 106–107
HandBrake general settings, 107–109
previewing video output, 109–111
video, encoding, 111
VLC, 105

Time Capsule
defined, 58
creating port mappings in, 75–79

Time Machine, 201–206
Title pop-up menu (HandBrake), 104
titles, slideshows, 141
tokens, search, 11
tone, fixing (iPhoto), 133–134
Track Editor (GarageBand), 192–193, 195
trackpad, finding preferences, 19
TUAW, 40
Type Less Project, 173–178

acquiring TextExpander, 173–174
newsletter, 174
snippets, adding premade, 177–178
snippets, creating, 175–177

U
updating

apps, 36–39
bootable clones, 212–214

USB audio mixers, 187
USB microphones, 187
users, remote login and, 59–60

V
Versions, using with Time Machine, 208–209
Video tab (iTunes), 117, 120–121
videos. See Throw Away Your DVDs Project
views

Finder, 3–4
full-screen mode, 179–181

virtual security, 67
VLC, HandBrake and, 105
vnc:// prefix, 70
voices, recording with GarageBand, 189
VoodooPad, 40–41

W
Web

searches, Spotlight and, 16
using Dropbox on, 94–99

Web pages
adding to sites, 151–152
settings, 154–156
sharing, 53
welcome pages, adding, 152–153

Web sites for downloading
HandBrake, 103
Heltweetica, 34
SuperDuper!, 210
TextExpander, 173
VoodooPad, 40
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Web sites for further information
Apple, 40
Flare, 135
Mac apps, 40
RealMac Software, 147

Web sites, Screen Sharing and (iChat Theater), 
52–55

webcams, for capturing signatures, 215, 216, 220
welcome pages, adding, 152–153
Where section (iTunes), 126–127
wizards

Advanced Setup wizard (Dropbox), 86–87
Dropbox Setup wizard, 84–86
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